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Introduction

The Bay Area Air Quality Management District’s (BAAQMD’s) Greenhouse Gas Model (BGM) 
is an Excel spreadsheet program that allows users to estimate operational greenhouse gas (GHG)
emissions from land development projects.  BGM does not estimate GHG’s generated during 
construction.  To run BGM, users must have either Excel 2007 or Excel 2003 installed on their 
computer.

BGM reads URBEMIS2007 project files to generate a portion of a project’s GHG emission 
estimates.  To run BGM, the user must also have URBEMIS2007, version 9.2.4, installed on 
their computer. URBEMIS2007 can be downloaded from http://www.urbemis.com.  The user 
must have created an URBEMIS project file that can be read by BGM.  URBEMIS2007 project 
files use the extension: .urb924.  

Users should have at least a rudimentary knowledge of both URBEMIS and Excel to run 
BGM.

This User’s Manual is organized into two separate sections.  The first section describes how to 
install and run BGM.  The second section describes how BGM calculates GHG emissions.

Section 1.  How to Install and Run BGM

Installation
BGM has been developed to be used with Excel 2003 and Excel 2007.  To install BGM, 
download the installation file from the BAAQMD’s website.  Double click on the installation file 
to initiate installation.  The BGM spreadsheet automatically installs the BGM spreadsheet at: 
C:\Program Files\URBEMIS\BGM Greenhouse Gas Calculator\BGM_Template.xls.

Running BGM
Once installed, BGM places an icon on the desktop:  

Clicking on this icon starts BGM and places you on BGM’s Help tab, which is shown in Figure 
1.
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Figure 1.  Help Tab
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The BGM help tab lists four steps that the user should follow to run BGM.  In addition to these 
four steps, the user should note that BGM contains fifteen tabs listed at the bottom of the 
spreadsheet:  

1. Help
2. Settings
3. Results
4. Transportation
5. Area Source
6. Elec(tric) & Natural Gas
7. Water & Wastewater
8. Solid Waste
9. Ag(ricuture)
10. Off Road Equip(ment)
11. Refrigerants
12. Mitigation
13. Sequestration
14. Transp(ortation) Detail Mit(igated)
15. Land Use Detail (not shown in Figure 1).

The use of these tabs is described in Steps 2, 3, and 4 below.

Step 1. Enable Macros
Step 1 requires that the user ensure that their version of Excel has been setup to allow macros.  If 
Excel has been set to not allow macros, then the “Enable All Macros” option should be turned 
on.  Within Excel 2007, macro security is set by going to the Developer Tab within the Ribbon 
Menu at the top of the screen, and then selecting the Macro Security option.  Within Excel 2003, 
macro security is set by going to the Tools Tab within the Ribbon Menu at the top of the screen, 
and then selecting the Macro option within the Tools tab. 

Step 2. Run an URBEMIS Project File and Refresh URBEMIS Data
Once macros have been turned on, the next step is to load one or more URBEMIS project files.  
URBEMIS project files are selected within the Settings tab.  To load an URBEMIS file, the 
BGM user should click on the Open an URBEMIS Project File link shown on the Help tab
(which takes you to the Settings tab), or click on the Settings tab found at the bottom of the 
spreadsheet.

Figure 2 shows the URBEMIS Settings tab. The Settings tab includes seven buttons plus a check 

box.  To load an URBEMIS file, click on the top button- -
which allows you to navigate to the URBEMIS project file location.

The second button - - runs the URBEMIS project file and 
places the results in the correct locations within BGM.
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Figure 2. Settings Tab
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BGM also allows the user to run an URBEMIS baseline file, though this is optional.  To do this, 

click on the button to identify the URBEMIS file to be used as 
the baseline project.

Then, click on the fourth button to place the results of the baseline file into the correct location of 

BGM.

The user should note that within the Settings tab there is a checkbox highlighted in yellow.  If 
checked, then BGM will use the Baseline Project file to calculate a project’s net emissions 
increase (project emissions minus baseline emissions).  If this checkbox is turned off, BGM will 
ignore the Baseline data and will only calculate project emissions.

In order for BGM to make the URBEMIS run(s) for the project and baseline, it must know the 
location of the URBEMIS EMFAC2007 files needed to make those runs.  BGM has been setup 
to look for the EMFAC2007 files in the default location found in the URBEMIS configuration
file. If the location of the EMFAC2007 files has been changed, you will need to specify the 

correct location by clicking on the button:

The last button resets BGM to look for the EMFAC2007 
files in the default location.

In addition to the six buttons described above, there is a seventh button:

When the Clear Data button is selected, all data entered into the spreadsheet is deleted. This 
button should be used with caution as any entered data will be removed, including any
URBEMIS files that have been selected.  

A few notes of caution: 
1) BGM requires that the Project file be imported from URBEMIS.  Consequently, the 
operational year specified within the URBEMIS project file becomes the year for which all 
project emissions are calculated in BGM.  You cannot change this year within BGM.  To change 
the project year, you must go back into URBEMIS and change the project year. The same 
situation holds for the baseline project and year.  To change the baseline project year, you must 
also change it within URBEMIS.

2) If the URBEMIS file that you are importing includes completed “blank” land uses, then the 
transportation and area source emissions will include the emissions for those blank land uses.  
However, other areas of BGM that use URBEMIS land uses - the electricity and natural gas tab, 
the water and wastewater tab, and the solid waste tab – do not import completed blank land use 
information from URBEMIS.  Consequently, the BGM user must go into these three tabs and 
enter blank land use information.  Blank land uses are discussed in detail in the last section of 
this manual
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Step 3. Data Entry Options
Once the URBEMIS file(s) have been imported into BGM, the next step is to enter project data 
for specific tabs.  As mentioned above, BGM contains 15 tabs:

1. Help
2. Settings
3. Results
4. Transportation
5. Area Source
6. Elec(tric) & Natural Gas
7. Waste and Wastewater
8. Solid Waste
9. Ag(ricuture)
10. Off Road Equipment
11. Refrigerants
12. Mitigation
13. Sequestration
14. Transp(ortation) Detail Mit(igated)
15. Land Use Detail

These 15 tabs can be grouped into four categories. These include tabs where:  
 user input is required to initiate the model (purple, 1 tab),
 no user input is required (yellow, 6 tabs), 
 user input is optional and/or minimal (green, 3 tabs), and 
 user input is required to generate or mitigate emissions (blue, 5 tabs).

Figure 3 illustrates how the BGM model emission estimates are made.
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Figure 3. BGM Model Flowchart
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Tab Where User Input is Required to Start the Model

Settings Tab
The Settings Tab is used to identify and run the URBEMIS files that are loaded into BGM.  
Section 2, on page 3 of this manual, describes how to load URBEMIS files within the Settings 
tab.

Tabs Where No User Input is Required

Help Tab
The Help tab, discussed in Step 1, provides guidance on making a BGM run. The Help tab is 
shown when the BGM model is started.  No user input is directly required on the Help tab, 
although the user may have to turn on macros if Excel has been set to not allow them to run, as 
described above in Step 1.  

Results Tab
The results tab summarizes the emission results, but no user input or changes can be made within 
it.  BGM produces two types of output: summary and detailed. Step 4 below describes the results 
tab in more detail.

Transportation and Area Source Tabs
Once you have imported an URBEMIS file into BGM (from within the Settings Tab), BGM uses 
the URBEMIS results to complete the transportation and area source tabs. The user cannot make 
any changes to data in either of these tabs.  In addition, BGM imports transportation-related 
assumptions and mitigation detail into two tabs:  Transp. Detail Mit. And Land Use Detail.  The 
user cannot directly change information in these tabs.  The only way to change information in 
this tab is to change values in the URBEMIS model, and then refresh the data in the Settings tab, 
so that the revised URBEMIS data is imported into BGM.

Transp. Detail Mit. And Land Use Detail Tabs
See discussion of these two tabs in the previous paragraph.

Tabs Generating Emissions Where User Input is Optional
Three of the tabs generate emission estimates without any user input (except for importing of 
URBEMIS files).  However, the user should make sure that the information shown in these tabs 
is accurate for their project.  Each of these is discussed separately below.

Electric and Natural Gas
BGM’s electricity and natural gas tab estimate GHG emissions in two steps.  In the first step, 
BGM estimates the amount of electricity and natural gas that will be required for a project. To do 
this, the size of each individual land use for a project is imported from URBEMIS.  With that 
information, BGM estimates the amount of electricity and natural gas that will be used, based on 
existing energy use information for climate zones 4 and 5.  BGM then uses the energy use 
estimates to calculate GHG emissions.

The BGM user does not need to enter any information to generate GHG emissions associated 
with electricity and natural gas use.  However, the BGM user should check that the correct 
climate zone is selected for their project (shown as yellow cells on the Electric and Natural Gas 
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tab and in Figure 4 below).  A map of the two 
electricity and natural gas tab.  

In addition to selecting the correct climate 
default energy use estimates for each land use.  These are identified by the 
the worksheet. For example, if an energy demand report has been prepared for a proj
may want to override the BGM energy use estimates with those included in the energy report.  
The energy and natural gas tab also includes a button that removes all 
been entered.  

Figure 4. Electricity and Natural Gas User Data Entry Options
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default energy use estimates for each land use.  These are identified by the peach 
the worksheet. For example, if an energy demand report has been prepared for a proj
may want to override the BGM energy use estimates with those included in the energy report.  
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climate zones is shown on the 

, the BGM user has the option of overriding the 
peach colored cells on 

the worksheet. For example, if an energy demand report has been prepared for a project, the user 
may want to override the BGM energy use estimates with those included in the energy report.  

user override data that has 
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Water and Wastewater
The Water and Wastewater tab uses a three step process to estimate GHG emissions.  Water and 
wastewater use are estimated based on land use information imported from URBEMIS. Then, 
electricity use associated with water use and wastewater generated is estimated.  Finally, the 
GHG emissions associated with that electricity use are estimated.  

The BGM user does not need to enter any information to generate GHG emissions associated 
with water and wastewater use.  However, the user has the option of overriding the model’s 
estimates of how much water would be required for a project (see Figure 5).  This may be 
necessary if a water demand estimate has been prepared specifically for the project being 
analyzed.

Figure 5. Water and Wastewater User Data Entry Options
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Solid Waste
The Solid Waste tab generates GHG emissions using a two step process.  First, the amount of 
waste generated for a project is estimated using the land use information imported from 
URBEMIS.  Then, based on the amount of waste generated, BGM estimates GHG emissions. 

The BGM user does not need to enter any information to generate GHG emissions associated 
with solid waste generation.  However, the user should check that the correct landfill disposal 
option is selected: 1) landfilling only 2) landfilling with flaring to burn methane, or 3) landfilling 
with energy recovery (Figure 6).  These three options are shown as yellow cells on the solid 
waste tab.

Figure 6. Solid Waste Data Entry Options
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In addition to selecting the correct landfill treatment option, the BGM user has the option of 
overriding some of the default data used by BGM.  The default data can be overridden by 
entering information in the peach tabs.  The default values that can be overridden are: 1) truck 
hauling load size and distance and 2) BGM’s estimates of solid waste that would generated for 
each land use.

Tabs that Generate No Emissions or Emission Reductions Without User Input
Five of the tabs require that information be entered to either generate emissions - agriculture, off-
road equipment, and refrigerants - or to mitigate emissions – sequestration and mitigation.  Many 
projects may not include any agricultural sources, off-road equipment, or refrigeration 
equipment.  For those projects, these tabs may not be relevant to your project and can be ignored.

Ag(ricuture)
The agriculture tab can be used to estimate emissions from livestock, from fuel combustion 
associated with equipment operation, from electricity use, and from fertilizer application.  Since 
there is no information imported from URBEMIS that can be used to estimate agricultural
emissions, the user must enter that information.  The user must enter the number of animals (if 
applicable) as shown in Figure 7.  If the project includes agricultural fuel use, electricity use, 
and/or fertilizer application, then those amounts must also be entered, as shown in Figure 8. The 
cells highlighted in yellow within the ag tab show the locations where data must be entered to 
generate emissions.
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Figure 7. Agricultural Data Entry for Number of Animals
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Figure 8. Agricultural Data Entry Areas for Fuel Use, Electricity Use, and Fertilizer Application

Off Road Equipment
Like the agriculture tab, no information is available from URBEMIS that can be used to estimate 
off-road equipment emissions associated with project operation. (URBEMIS only generates 
emissions for off-road equipment in its construction phase.)  Certain land uses, however, may 
use off-road equipment during their normal course of operations.  For example, an industrial 
facility may use forklifts and/or generators during the normal course of business activity.  For 
these situations, the off-road equipment tab can be used to estimate emissions.  The user will 
need to enter the annual gallons used per year of diesel, gasoline, and/or propane.  This 
information is entered in the cells highlighted in yellow, as shown in Figure 9.
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Figure 9.  Off-Road Equipment Fuel Use Data Entry 

Refrigerants
Certain land uses like grocery stores and some industrial users have large refrigeration systems.  
Like the agriculture and off-road equipment tabs, BGM will not estimate refrigerant-related 
GHG emissions unless the user enters project specific information.  

The user must enter the amount of refrigerant charge (pounds of refrigerant) required for the 
project’s refrigeration and air conditioning systems (see Figure 10).  These areas are highlighted 
as yellow cells.  With that information, and default information on leakage rates, BGM estimates 
the amount of refrigerant that leaks per year.  The user has the option of overriding BGM’s 
estimate of the amount of refrigerant leaked per year by entering an override amount in the cells 
highlighted in peach.  BGM also includes an estimate of the global warming potential of the 
refrigerants, which it multiplies by the leakage amount to generate estimates of GHG emitted.  If 
the user knows the type of refrigerant that will be used, then the global warming potential (GWP)
of that refrigerant should be entered in the User Override of GWP cell(s), also highlighted in 
peach.
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Figure 10. Refrigerant User Data Entry and Override Options

Mitigation
The mitigation tab allows the user to select specific mitigation measures that apply to their 
project.  Each of the mitigation measures listed works in a similar manner.  The user turns the 
measure on by clicking on the check box, and the user has the option of entering mitigation 
specific information for each measure.  Although the mitigated emissions are summarized on the 
Summary tab, they are also shown in the Mitigation tab so that users can observe the effects of 
turning various mitigation measures on and off.  The various mitigation measures are described 
below.

Transportation and Area Source Mitigation
Although mitigation can be specified for transportation and area sources, that mitigation must be 
specified within the URBEMIS model.  It cannot be specified from within BGM.  Within 
URBEMIS, if mitigation measures have been specified for transportation and/or area sources, 
then those mitigated emissions are also imported into BGM when the user selects the URBEMIS 
input file from within the BGM Settings tab.  The list of transportation-related mitigation 
measures selected within URBEMIS is shown in the Transp(ortation) Detail Mit(igation) tab.

Electricity and Natural Gas Mitigation
Figure 11 shows BGM’s mitigation options for electricity and natural gas.  To select a mitigation 
measure, the user must click on the box to turn it on.  In addition, the user should enter the 
amount of gas reduced (MMBtu/year) and/or electricity reduced (kwh/year) for each measure 
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selected.  One measure, cool roofs/green roofs, allows the user to enter both the annual change in 
electricity and natural gas use.  This is because studies have shown that while cool roofs reduce 
electricity demand during the summer months, they increase natural gas demand during the 
winter months.

Figure 11. Electricity and Natural Gas Mitigation Measures

Water and Wastewater Mitigation
Figure 5 shows the two mitigation measures that apply to water and wastewater.  The user has 
the option of turning these two options on and changing the % of water use reduction for each 
measure.  As is evident by Figure 12, the drought tolerant landscaping measure only reduces 
outdoor water use, while low flush toilets only reduce indoor water use.

Figure 12. Water and Wastewater Mitigation

Solid Waste Mitigation
Currently, BGM only includes one mitigation measure for solid waste (Figure 13).  That measure 
reduces the amount of solid waste generated by a project.  To apply this measure, the user must 
click the check box to turn it on and enter the percentage reduction that applies.
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Figure 13.  Solid Waste Mitigation

Agriculture and Off-Road Mitigation
For the agricultural and off-road categories, BGM does not currently include any mitigation 
measures. 

Refrigerants Mitigation
For the refrigerants category, BGM only includes one mitigation measure (Figure 14).  This 
measure would replace the use of CFCs and HCFCs with ammonia, which results in a 100% 
reduction.

Figure 14. Refrigerant Mitigation

Offsets Mitigation
One final mitigation measure is included in BGM: Purchase Emission Offsets/Credits. To use 
this measure, the user must click the check box and specify the metric tons of carbon dioxide 
equivalent (CO2e) per year that will be offset (see Figure 15).

Figure 15. Offsets/Credit Mitigation Option

Step 4. View Results
The results tab includes both a summary and a detailed results section.  
The summary section shows unmitigated minus baseline emissions (CO2e/year) and mitigated 
minus baseline emissions in table and graphical format, as shown in Figure 16.  This graph 
allows the user to quickly see which emission categories contribute the most to GHG emissions.  
The graph also shows how efficient the various mitigation measures are at reducing GHG 
emissions.

The results tab also includes a detailed section that shows emissions for each emission category.  
Three tables are listed, unmitigated, mitigated, and baseline conditions.  For each of these tables, 
carbon dioxide (CO2), methane (CH4), and nitrous oxide (N2O) and CO2e emissions are listed.  
Also, for the mitigation emissions, each mitigation measure that has been selected is shown 
below the mitigated results table.
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Figure 16. Summary Results
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Section 2.  How BGM Estimates GHG Emissions

Section 1 describes what the BGM user needs to do to generate GHG emissions using the BGM 
model.  Section 2 describes how BGM generates those emissions.  A separate discussion is 
included for each BGM tab that is used to estimate or mitigate emissions.

Transportation Tab
Within the transportation tab, BGM imports transportation emissions in tons of CO2 per year as 
estimated by URBEMIS (see Figure 17). 

Conversion from English to Metric
BGM first converts the URBEMIS value to metric tons CO2 per year by multiplying by 2000 
lbs/ton / 2204 lbs/metric ton.  

Figure 17. Transportation Emission Screen

Pavley Regulation Adjustment
In the next step, BGM adjusts transportation emissions to account for the Pavley regulations. The 
Pavley regulations reduce GHG emissions in light duty autos and trucks, and medium duty 
trucks from 2009 through 2016.  Consequently, the Pavley emission reductions are only applied 
to a percentage of the total vehicle fleet.  They do not affect other vehicles, such as heavy duty 
vehicles, buses, and motorcycles.

Table 1 shows the emission reduction percentages applied to light duty autos (LDA), light duty 
trucks (LDT1 and LDT2) and medium duty vehicles (MDV) by year applied.
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Table 1. Pavley Percentage GHG Reductions by Year and Vehicle Class

Year % CO2

Reduction 
- LDA

% CO2

Reduction 
- LDT1

% CO2

Reduction 
- LDT2

% CO2

Reduction 
MDV

2009 0.00% 0.00% 0.07% 0.08%

2010 0.35% 0.25% 0.45% 0.48%

2011 1.75% 1.34% 1.31% 1.29%

2012 4.07% 3.27% 2.60% 2.44%

2013 6.31% 5.26% 3.88% 3.61%

2014 8.48% 7.26% 5.17% 4.83%

2015 10.74% 9.38% 6.54% 6.17%

2016 12.96% 11.56% 7.94% 7.54%

2017 15.03% 13.58% 9.27% 8.88%

2018 16.94% 15.43% 10.54% 10.16%

2019 18.72% 17.13% 11.74% 11.40%

2020 20.37% 18.69% 12.89% 12.59%

2025 26.87% 24.86% 17.60% 17.42%

2030 30.60% 28.71% 20.63% 20.47%

2035 32.38% 31.17% 22.43% 22.29%

2040 33.27% 32.61% 23.60% 23.53%

The information in Table 1 was estimated using the Pavley 1-LCFS post-processor developed by 
the California Air Resources Board (2010).  To run the post-processor, separate EMFAC2007 
Burden runs were made for the BAAQMD for the years 2009-2020,2025,2030,2035, and 2040.  
Each of these years was then read by the Pavley 1-LCFC post-processor to obtain weekday CO2

emissions for each of the four vehicle classes in Table 1.

Table 2 shows the post-processor results for 2010.  The Pavley regulations would reduce 2010 
BAAQMD CO2 emissions by 0.35% for LDA, by 0.25% for LDT1, by 0.45% for LDT2, and by 
0.48% for MDV.  Calculations similar to those shown in Table 2 were made for each year 
included in the BGM.  The BGM spreadsheet assumes that the percentage reductions as 
calculated for the entire BAAQMD would be the same for individual projects.  This may not be 
the case if the user has changed the default fleet mix within URBEMIS.  Consequently, the user 
should use caution if the default fleet mix has been changed within the URBEMIS model.
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Table 2.  Pavley Post-Processor Results for the BAAQMD in 2010

Vehicle Category

Weekday CO2
Emissions from 

EMFAC 
(tons/day)

% CO2
Emissions

Weekday CO2
Emission 

Reduction from 
Pavley I 

(tons/day)

Annual CO2
Emissions after 
adopting Pavley

I & LCFS 
(MMT

CO2/year)

% CO2 
Emission 

Reduction 
from 

Pavley

LDA 39,805.91 41.72% 139.41 12.49 0.35%

LDT1 11,818.53 12.39% 29.80 3.71 0.25%

LDT2 18,646.46 19.54% 84.12 5.84 0.45%

MDV 9,165.16 9.61% 44.24 2.87 0.48%

Total 79,436.06 83.26% 297.57 24.91 0.37%

All other Cat 15,973.94 16.74% 0.00 0.00%

Grand Total 95,410.00 100.00% 297.57 0.31%

Source: California Air Resources Board, 2010

CO2 to CO2e Conversion
After the Pavley calculations have been made, BGM converts CO2 emissions into CO2e
emissions to account for the U.S. EPA finding that GHG emissions from other pollutants – CH4, 
N2O, and refrigerants from leaking air conditions – account for 5% of total GHGs from vehicles, 
after each pollutant’s global warming potential has been taken into account (U.S. Environmental 
Protection Agency, 2005).

Low Carbon Fuels Rule Conversion
Finally, BGM adjusts transportation emissions to account for the Low Carbon Fuels Rule
(LCFR). LCFR applies to all vehicles.  Table 3 shows the emission reduction percentages 
applied as a result of the LCFR.
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Table 3. Low Carbon Fuel Rule Percentage GHG Reductions

Year

% CO2e
Reduction 

Gasoline and 
Diesel Fuel

2010 0.00

2011 0.25

2012 0.50

2013 1.00

2014 1.50

2015 2.50

2016 3.50

2017 5.00

2018 6.50

2019 8.00

2020 - 2040 10.00

Source: California Air Resources 
Board, 2009a

Area Source Tab
Area source emissions use as a starting point the area source emissions for hearths and landscape 
maintenance equipment as calculated by URBEMIS2007, version 9.2.4.  The hearth and 
landscape maintenance CO2 emissions (English tons per year) are imported from URBEMIS into 
the Area Source tab and converted to metric tons in the first line (see Figure 18).  

The consumer product and architectural coatings categories in URBEMIS do not include any 
GHG emissions and, consequently, are not imported into BGM.  Although the area source 
component of URBEMIS estimates natural gas-related CO2 emissions, those emissions are not 
imported into BGM.  Instead, natural gas related- CO2 emissions are calculated in the Electricity 
and Natural Gas tab as explained in the following section.

Once BGM has imported hearth and landscape maintenance equipment, two additional 
calculations are made, both for hearth emissions.  First, BGM estimates N2O emissions 
associated with wood burning fireplaces and natural gas fireplaces (U.S. EPA, 1998, U.S. EPA, 
1996a.)  NO2 emission factors are not available for wood burning stoves.

Then, CH4 emissions are estimated for wood burning stoves and natural gas fireplaces (U.S. EPA 
1998 and U.S. EPA 1996b).  CH4 emission factors are not available for wood burning fireplaces
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Figure 18. Area Source Emissions

Electricity & Natural Gas Tab
In the electricity/natural gas tab, GHG emissions are calculated using a two step process.  First, 
BGM estimates the amount of electricity and natural gas for each land use. If the user has a 
better estimate of electricity and/or natural gas use, then BGM’s estimates can be overridden.  

Once the user is satisfied with the electricity and natural gas values, GHG emissions associated 
with that energy use are calculated.  

Step 1 – Estimate Electricity and Natural Gas Use
BGM imports project specific information directly from URBEMIS, specifically the size of each 
land use: number of single family and multi-family units and the square footage of non-
residential land uses.  

Within this tab, the user must enter the climate zone in which the project is located.  Figure 19
shows that the BAAQMD is located within climate zones 4 and 5.
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Figure 19. Climate Zones within the California Commercial End-Use Survey

Electricity and Natural Gas Use - Residential
BGM estimates average residential electricity and natural gas use based on the California 
Residential Appliance Saturation Study.  The results of this study were used to estimate energy 
use for the average single family and multi-family residence.  The data was sufficient to estimate 
average electricity use for the two housing types for the two climate zones (Table 4).  However, 
for natural gas use, separate use estimates were not available for the two climate zones.

Electricity and Natural Gas Use – Non-Residential
To estimate non-residential electricity and natural gas use, BGM uses the California Commercial 
End-Use Survey, published by the California Energy Commission (2006). The survey contains 
natural gas (and electricity) consumption data by major utility and climate zone, and by 
commercial end use.  
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Table 4. Average Residential Electricity Use by Climate Zone

Single Family 
Residential

Multi-Family 
Residential

Electricity Use – Climate 
Zone 4

7415 kwh/year 4434 kwh/year

Electricity Use – Climate 
Zone 5

6047 kwh/year 3685 kwh/year

Natural Gas Use –
Climate Zones 4 and 5

49.6 MMBtu/year 22.5 MMBtu/year

The California Commercial End-Use Survey includes an online database that allows the user to 
estimate average natural gas and electricity use for any of California’s 15 climatic zones, and for 
any of several building types within each zone.  Using this database, BGM estimates average 
natural gas and electricity use data for individual climate zones, and for individual land uses 
within each climate zone.  Table 5 shows the electricity and natural gas usage rates by land use 
and climate zone as derived from the California Commercial End-Use Survey.

Table 5. Electricity and Natural Gas Usage Rates by Land Use and Climate Zone

Climate Zone 4 Summary Climate Zone 5 Summary

Electric 
(kwh/sf)

Natural Gas 
(kBtu/sf)

Electric 
(kwh/sf)

Natural Gas 
(kBtu/sf)

All Commercial 13.6 29.49 13.2 31.7

Small Office (<30,000 sf) 17.4 9.7 14.5 30.0

Large Office (>= 30,000 sf) 23.5 26.4 15.2 23.3

Restaurant 36.0 212.5 31.4 171.1

Retail 12.8 3.0 12.6 5.5

Food Store 44.3 25.8 40.3 41.4

Refrigerated Warehouse 10.1 3.9 24.9 18.7

Unrefrigerated Warehouse 4.3 4.4 4.6 1.7

School 6.7 22.7 5.5 19.6

College 9.8 27.5 12.7 41.8

Health 23.0 118.7 18.4 110.7

Lodging 9.3 47.0 10.0 39.1

Miscellaneous 9.8 29.7 9.0 27.2

All Offices 21.3 20.5 15.1 24.3

All Warehouses 5.8 4.3 7.7 4.3

BGM uses this CEC database to estimate natural gas use for each land use type within 
URBEMIS.  The one problem with this approach is that the land use types in URBEMIS do not 
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perfectly match those in the CEC database.  The CEC database includes the following fifteen 
land uses:

1. All Commercial
2. Small Office (<30,000 sf)
3. Large Office (>=30,000 sf)
4. Restaurant
5. Retail
6. Food Store
7. Refrigerated Warehouse
8. Unrefrigerated Warehouse
9. School
10. College
11. Health
12. Lodging
13. Miscellaneous
14. All Offices
15. All Warehouses

In contrast, URBEMIS contains 43 non-residential land uses.  Table 6 shows the CEC database 
categories that BGM uses to estimate electricity and natural gas use for each land use.

Table 6.  CEC Database Category Used to Estimate Energy Use for Each URBEMIS Non-Residential Land 
Use

URBEMIS Land Use

CEC Commercial Use 
Category Used to 
Estimate BGM 
Electricity and 

Natural Gas Use
Day-Care Center School

Elementary School School
Junior High School School

High School School
Junior College College

University/College College
Library Small Office

Place of Worship Miscellaneous
City Park Miscellaneous

Racquet Club Retail
Racquetball/Health Retail
Quality Restaurant Restaurant

High Turnover/Sit-Down Restaurant Restaurant
Fast Food w/Drive Through Restaurant

Fast Food w/o Drive Through Restaurant
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Hotel Lodging
Motel Lodging

Free-Standing Discount Store Retail
Free-Standing Discount Superstore Retail

Discount Club Retail
Regional Shopping Center Retail

Electronic Superstore Retail
Home Improvement Superstore Retail

Strip Mall Retail
Hardware/Paint Store Retail

Supermarket Food Store
Convenience Market Food Store

Convenience Market w/gas pumps Food Store
Gasoline Service Station Retail
Bank w/Drive Through Small Office
General Office Building Large Office

Office Park Large Office
Government Office Building Large Office

Government Civic Center Large Office
Pharmacy w/Drive Through Retail

Pharmacy w/o Drive Through Retail
Medical Office Building Health

Hospital Health
Warehouse All Warehouses

General Light Industry All Warehouses
General Heavy Industry All Warehouses

Industrial Park All Warehouses
Manufacturing All Warehouses

The BGM user has the option of overriding BGM’s estimate of electricity and natural gas use.  

Step 2 – Estimate GHG Emissions Based on Electricity and Natural Gas Use
Once electricity and natural gas use has been estimated, BGM estimates GHG emissions using 
CO2, CH4, and N2O emission factors.  BGM uses California electricity and natural gas GHG 
emission factors as reported in the California Climate Action Registry’s General Reporting 
Protocol, version 2.2 (2009)  The resulting emissions are then converted to CO2e.
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Water Use Tab

BGM estimates GHG emissions associated with water use in a three step process. 

Step 1- Estimate Water Use
In the first step, BGM estimates the amount of water that a project would use and allocates this 

between indoor and outdoor use.  

To estimate water use, URBEMIS land use information is imported into the water use tab.  For 
single family and multi-family residential units, water use is estimated by multiplying the 
number of residential units by the average persons per unit and by the average gallons consumed 
per capita.  The average persons per unit can be modified by the user. Water use estimates are 
summarized in Table 7.  The project year is used to identify the correct water use values

For non-residential land uses, the information in Table 7 is also used to estimate water use, 
except that the square footage must be converted to number of employees. Table 8 shows the 
values used to convert building square footage into the number of employees.  Table 8 also 
shows the URBEMIS land uses that were assumed to match the employee per square foot values.  
BGM allows the user to overwrite the square footage per employee.

Table 7.  Water Use Estimates with the San Francisco Area

Year
Single Family (gallons a day/ 

capita)
Multi-family (gallons a day/ 

capita)
Non-Res (gallons a day/ 

employee)
2001 108.00 75.00 86.00

2002 107.79 74.72 85.97

2003 107.59 74.45 85.93

2004 107.38 74.17 85.90

2005 107.17 73.90 85.86

2006 106.97 73.62 85.83

2007 106.76 73.34 85.79

2008 106.55 73.07 85.76

2009 106.34 72.79 85.72

2010 106.14 72.52 85.69

2011 105.93 72.24 85.66

2012 105.72 71.97 85.62

2013 105.52 71.69 85.59

2014 105.31 71.41 85.55

2015 105.10 71.14 85.52

2016 104.90 70.86 85.48

2017 104.69 70.59 85.45

2018 104.48 70.31 85.41
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2019 104.28 70.03 85.38

2020 104.07 69.76 85.34

2021 103.86 69.48 85.31

2022 103.66 69.21 85.28

2023 103.45 68.93 85.24

2024 103.24 68.66 85.21

2025 103.03 68.38 85.17

2026 102.83 68.10 85.14

2027 102.62 67.83 85.10

2028 102.41 67.55 85.07

2029 102.21 67.28 85.03

2030 102.00 67.00 85.00

Source:  URS Corporation and Maddeaus Water Management, 2004.

Table 8.  Land Use Types and Square Feet per Employee

Land Use Type Square Feet per 
Employee

URBEMIS Land Use

Warehouse 1,700.00
Warehouse, General Light Industry, General Heavy 
Industry, Industrial Park, Manufacturing

Public Assembly 1,300.00 City Park

Lodging 1,300.00 Hotel, Motel

Food Sales 1,000.00
Supermarket, Convenience Market, Convenience Market 
w/Gas Pumps

Retail and Service 900.00

Racquetball Club, Racquetball/Health, Free-Standing 
Discount Store, Free-Standing Discount Superstore, 
Discount Club, Regional Shopping Center, Electronic 
Superstore, Home Improvement Superstore, Strip Mall, 
Bank w/Drive Through, Pharmacy w/Drive Through, 
Pharmacy w/o Drive Through

Education 766.00
Day Care Center, Elementary School, Junior High, High 
School, Junior College, University/College/Library

Food Service 600.00
Quality Restaurant/High Turnover Sit-Down Restaurant, 
Fast Food w/Drive Through, Fast Food w/o Drive 
Through

Other 550.00 Place of Worship, Gasoline Service Station

Health Care 500.00 Medical Office Building, Hospital

Office 400.00
General Office Building, Office Park, Government 
Office Building, Government Civic Center

Source: Energy Information Administration, 1995.
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Once BGM estimates water use, the user has the option of overriding those water use estimates.  
Then, using the water use estimates, BGM estimates the amount of indoor versus outdoor water 
use using the percentages shown in Table 9.

Table 9.  Indoor versus Outdoor Water use Percentages

Indoor vs. Outdoor Water Use

Year Indoor Outdoor Total

2001-2005 0.64 0.36 1.00

2006-2015 0.63 0.37 1.00

2016-2025 0.62 0.38 1.00

2026-2030 0.61 0.39 1.00

Source: URS and Maddaeus Water Management, 2004

Step 2. Estimate Electricity Demand Resulting from Water Use

Once water use has been entered, BGM estimates the electricity demand associated with that use.  
The emission rates applied to water use are based on a report prepared for the California Energy 
Commission (Navigant, 2006).  Table 10 summarizes the electricity associated with water use.  
For BGM, the Northern California water energy values are used.

Step 3. Estimate GHG Emissions Associated with Electricity Demand

Once electricity use associated with indoor and outdoor uses have been estimated, BGM 
estimates the GHGs associated with that electricity use using the same GHG emission factors as 
described in the Electricity and Natural Gas discussion.

Table 10. Energy Use Associated with Water and Wastewater Consumption
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Solid Waste Tab
For solid waste, BGM uses the U.S. EPA WARM model emission factors to estimate GHG 
emissions.  

BGM uses a two step process.  In the first step, BGM estimates the amount of solid waste that 
the project will generate.  In the second step, BGM estimates the GHG emissions associated with 
that solid waste. Each step is described below.

Step 1 – Estimate Solid Waste Generation

BGM estimates solid waste generation using the land use types and sizes for a project as 
imported from URBEMIS.  BGM includes information on the tons of solid waste generated per 
single family and multi-family residence and per square foot of non-residential land use.  For 
single family units, solid waste generation was based on a disposal rate of 0.42 tons per resident 
per year times an average of 2.94 residents per unit.  For multi-family units, the solid waste 
generation was based on an estimate of 0.46 tons per residential unit per year (CalRecycle, 
2010a).

For non-residential land uses, BGM uses the solid waste generation rates shown in Table 11.

The user has the option of overriding BGM’s estimates of solid waste generation.
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Table 11. Non-Residential Solid Waste Generation Rates

PROJECT Nonresidential Land Use (From 
URBEMIS)

Estimated Solid 
Waste

Generation 
Rate (tons/sf/yr) Source:

Day-Care Center; Elementary School, Junior 
High School, High School, Junior College, 
University/College, Library, Place of Worship

0.0013 CalRecycle, 2010j

City Park
0.0000

No available 
source

Racquet Club, Racquetball/Health 0.0057 CalRecycle, 2010k
Quality Restaurant, High Turnover/Sit-Down 
Restaurant, Fast Food w/Drive Through, Fast 
Food w/o Drive Through

0.0009 CalRecycle, 2010i

Hotel, Motel 0.0108 CalRecycle, 2010h
Free-Standing Discount Store, Free-Standing 
Discount Superstore, Discount Club, Regional 
Shopping Center, Electronic Superstore, Home 
Improvement Superstore

0.0046 CalRecycle, 2010e

Strip Mall, Hardware/Paint Store, Convenience 
Market, Convenience Market w/gas pumps, 
Gasoline Service Station, Pharmacy w/Drive 
Through, Pharmacy w/o Drive Through

0.0024 CalRecycle, 2010g

Supermarket 0.0057 CalRecycle, 2010e
Bank w/Drive Through, General Office 
Building, Office Park, Government Office 
Building, Government Civic Center

0.0108 CalRecycle, 2010f

Medical Office Building, Hospital
0.0108

CalRecycle, 
2010d.

Warehouse, Manufacturing 0.0026 CalRecycle, 2010b
General Light Industry, General Heavy 
Industry, Industrial Park

0.0011 CalRecycle, 2010c

BGM uses a project’s solid waste generation to estimate the amount of truck hauling needed to 
dispose of this waste in a landfill.  BGM estimates the amount of truck hauling required based on 
the amount of waste generated per year, the average round trip haul distance, and the truck 
hauling capacity.  The user has the option of overriding the round trip haul distance and truck 
hauling capacity.  Using either the BGM default or user override values, BGM estimates the total 
truck vehicle miles traveled (VMT) per year for the project.

Step 2. Estimate Solid Waste GHG Emissions
The solid waste GHG emissions include two components: truck hauling emissions and emissions 
resulting from the decomposition of solid waste.  

Truck Hauling Emission Estimates
Truck hauling emissions use the VMT estimates described in Step 1 and multiply them by 
EMFAC2007 emission rates for heavy heavy-duty trucks.  An EMFAC2007 modeling run was 
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used to estimate CO2 and CH4 emissions in grams per mile for trucks traveling at an average 
speed of 35 mph.  Truck emissions also account for the Low Carbon Fuels Rule (California Air 
Resources Board, .

Solid Waste Decomposition Emission Estimates
BGM uses the U.S. EPA WARM Model emission rates for mixed solid waste decomposition.  
Those rates equal 3.1 metric tons of CO2e per short ton of solid waste that is landfilled, assuming 
no recovery, 0.64 tons CO2e per short ton, assuming landfilled waste with flaring, and 0.3 tons 
CO2e per short ton, assuming landfilled waste with energy recovery (U.S. EPA, 2009a).

Agriculture Tab
The agriculture tab allows users to enter information that BGM uses to generate GHG estimates.  
If no information is entered, then agricultural emissions are assumed to equal zero GHGs.  

The ag tab allows users to estimate:
 enteric and manure emissions from livestock, 
 fuel emissions associated with mobile source and stationary equipment, 
 electricity emissions, and 
 emissions associated with fertilizer application.

Livestock Emissions

To estimate livestock emissions, the BGM user must enter the number of animals in each of the 
categories as shown in Table 12.  With the livestock numbers, and enteric and manure emission 
factors, BGM estimates the enteric emissions and manure-related emissions associated with 
livestock.  Table 13 shows the enteric and manure emission factors used.

Table 12.  Livestock Data Entry Form

PROJECT Animals
Number of 
Animals

Enteric 
Fermentation 

Methane Emissions 
(metric tons/year)

Manure Emission 
Rates (metric tons 
methane per year)

Manure Emission 
Rates (metric tons 

N2O /year)

Beef Cattle 11.00 0.94 0.02 0.00

Beef Replacement Heifers 0.00 0.00 0.00

Steers 0.00 0.00 0.00

Bulls 0.00 0.00 0.00

Milk Cows 0.00 0.00 0.00

Dry Cows 0.00 0.00 0.00

Heifers, 15-24 months 0.00 0.00 0.00

Heifers, 7-14 months 0.00 0.00 0.00

Heifers, 4-6 months 0.00 0.00 0.00

Calves 0.00 0.00 0.00

Chickens (fryers) 0.00 0.00 0.00
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PROJECT Animals
Number of 
Animals

Enteric 
Fermentation 

Methane Emissions 
(metric tons/year)

Manure Emission 
Rates (metric tons 
methane per year)

Manure Emission 
Rates (metric tons 

N2O /year)

Goats, Hogs, Pigs 0.00 0.00 0.00

Sheep and Lambs 0.00 0.00 0.00 0.00

Turkeys 0.00 0.00 0.00 0.00

Totals 11.00 0.94 0.02 0.00

Table 13. Enteric Fermentation and Manure Emission Rates

Animal Type

Enteric 
Fermentation 

Emission Rates 
(metric tons 

CH4/head/yr)

Manure Emission 
Rates (metric tons 

CH4/head/yr)

Manure Emission 
Rates (metric tons 

N2O /head/yr)
Beef Cattle 0.085556 0.002158 0.000000
Beef Replacement 
Heifers

0.066208 0.001914 0.000000

Steers 0.033349 0.001470 0.000000
Bulls 0.053000 0.002793 0.000000
Milk Cows 0.116520 0.164125 0.000738
Dry Cows 0.116520 0.165125 0.000738
Heifers, 15-24 months 0.067047 0.002210 0.001620
Heifers, 7-14 months 0.042376 0.002210 0.001620
Heifers, 4-6 months 0.042376 0.002210 0.001620
Calves 0.042376 0.002210 0.001620
Chickens (fryers) 0.000000 0.000018 0.000002
Goats, Hogs, Pigs 0.001500 0.028228 0.000141
Sheep and Lambs 0.008000 0.000781 0.000002
Turkeys 0.000000 0.000086 0.000010

Agricultural and Stationary Equipment
The ag tab also allows users to estimate the amount of agricultural equipment emissions and 
stationary equipment emissions associated with their project.  To estimate emissions for these 
two categories, the user must enter the gallons of diesel fuel, gasoline, and propane that will be 
burned per year.  With that information, BGM uses emission factors developed by the California 
Climate Action Registry (2009) to estimate metric tons of CO2e emitted per year.  Similarly, for 
BGM to estimate electricity-related GHG emissions, the user must enter the amount of electricity
consumed per year.  BGM uses electricity related emission factors developed by the California 
Climate Action Registry (2009) to estimate metric tons of CO2e emitted per year.  
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The gasoline and diesel fuel use estimates assume the Low Carbon Fuel Standard will apply to 
these fuels.

Fertilizer Emissions
Finally, to estimate the amount of fertilizer (N2O) emissions emitted per year, the user must enter 
the tons of fertilizer applied annually.  

Off-Road Equipment Tab
Certain types of commercial and industrial land uses may use off-road equipment during their 
normal course of operations.  Equipment such as fork lifts, generators, pumps, or compressors 
are commonly used in certain industries.  The off-road equipment tab allows the user to quickly 
estimate GHG emission from off-road equipment.  

User input is required to estimate off-road equipment emissions.  The user must enter into BGM 
the annual fuel use – gasoline, diesel, and/or propane - for all off-road equipment.  With that 
information, BGM estimates the GHG emissions using emission factors developed by the 
California Climate Action Registry (2009), now called the Climate Registry.

BGM estimates GHG emissions using fuel use, and adjusts the resulting emissions to account for 
the LCFS.  The LCFS applies to gasoline and diesel combustion, but not to propane.

Refrigerants Tab
Many types of commercial and industrial land uses require refrigeration or air conditioning
(A/C) equipment as part of their normal course of operations.  These systems require refrigerants 
to operate.  In most cases, these refrigerants have a high GWP. Refrigerant leaks can contribute 
to a project’s GHG emissions.

BGM calculates GHG emissions by first multiplying refrigerant change by the annual leakage
rate.  The resulting annual refrigerant leakage is then multiplied by the refrigerant’s GWP to 
estimate CO2e.  

BGM does not attempt to guesstimate the amount of refrigerant charge for a project. 
Consequently, the user must enter information on refrigerant charge, otherwise BGM will not 
estimate GHG emissions for the refrigerant category.  The use must enter the quantity of 
refrigerant change in the correct category or categories of the eight categories listed.  These eight 
categories include four refrigeration system categories – centralized, cold storage, process 
cooling, and refrigerant condensing units – and four AC system categories – centrifugal chiller 
(large), centrifugal chiller (medium), packaged chiller (medium), and unitary AC (small).  

BGM assumes default leakage rates for each of these eight categories.  Those leakage rates are 
based on the California Air Resources Board’s Refrigerant Management Program rule, slated to 
take effect on January 2011.  The leakage rates can be found in the California Air Resources 
Board’s Appendix B. California Facilities and Greenhouse Gas Emissions Inventory – High-
Global Warming Potential Stationary Source Refrigerant Management Program (California Air 
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Resources Board, 2008). The user can override the total leakage per year.  The leakage rates
found in the ARB staff report are summarized in Table 14.

Table 14.  Refrigerant Leakage Rates Associated with ARB’s Proposed Refrigerant Management Program 
Rule

Refrigeration 
Systems

Default 
Leak Rate 

(%)
Centralized (large and medium) 10.00

Cold Storage (large and medium) 10.00

Process Cooling (medium) 7.00

Refrigerant Condensing Units (small) 5.00

AC Systems Centrifugal Chiller (large) 2.00

Centrifugal Chiller (medium) 1.00

Packaged Chiller (medium) 3.50

Unitary AC (small) 5.00

BGM also includes default GWP estimates for each of the eight system categories (see Table 
15).  Those default values are averages for each category taken from Table 5 of the California 
Air Resources Board staff report (2008).  The ARB report shows how refrigerant use is estimated 
to change between 2010 and 2020.  This change is reflected in the default GWP estimated by 
BGM.  Changing the year of the analysis also changes the GWP used by BGM.  If the user 
knows the refrigerant that will be used however, they have the option of overriding the default 
GWP used by BGM.  

Table 15. Weighted Global Warming Potential by Type of Refrigerant

Refrigerant 
Distribution Refrigerant Type

Global 
Warming 
Potential 2010

Centralized Systems GWP % of Total

HCFC-22 1,500 42.20

R-404A 3,260 39.70

R-507 3,300 18.10

Weighted GWP 2,524.52

Cold Storage

CFC-12 8,100 2.00

HCFC-22 1,500 56.60

R-404A 3,260 26.20

R-502 4,500 6.60

R-507 3,300 8.60

Weighted GWP 2,445.92
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Refrigerant 
Distribution Refrigerant Type

Global 
Warming 
Potential 2010

Process Cooling

CFC-11 3,800 1.00

CFC-12 8,100 15.60

HCFC-22 1,500 22.00

HCFC-123 90 23.30

HFC-134A 1,300 33.30

R-401A 970 0.40

R-404a 3,260 2.70

R-410A 1,725 0.90

R-507 3,300 0.90

Weighted GWP 2,222.60

Refrigerated 
Condensing Units

CFC-12 8,100 2.20

HCFC-22 1,500 30.40

HFC-134a 1,300 40.40

R-404a 3,260 19.00

R-507 3,300 8.00

Weighted GWP 2,042.80

Chillers

CFC-11 3,800 2.60

CFC-12 8,100 0.90

HCFC-22 1,500 73.80

HCFC-123 90 6.80

CFC-114 9,300 0.10

HFC-134A 1,300 14.10

HFC-236fa 6,300 0.40

R-407a 1,526 1.00

R-410a 1,725 0.10

R-500 6,010 0.20

Weighted GWP 1,531.63

Unitary AC

HCFC-22 1,500 78.40

HFC-134a 1,300 0.10

R-407a 1,526 0.30

R-410a 1,725 21.20

Weighted GWP 1,547.58

Source: California Air Resources Board, 2008
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Mitigation Tab
Figure 20 shows the individual mitigation measures that can currently be set within BGM.  
Carbon sequestration, also considered to be a mitigation measure, is 
next section.  Within the mitigation tab, t
option of specifying the amount of mitigation.  

Figure 20. Individual Mitigation Measures within BGM
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Within the mitigation tab, the user can turn each measure on or off, and has the 
option of specifying the amount of mitigation.  
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For example, the user can select solar water heaters, and can edit the amount of million Btu/year 
of natural gas that would be avoided or reduced.  For each of the electricity and natural gas
mitigation measures, the user must enter the amount of natural gas or electricity that would be 
reduced.  The user should also note that the cool roofs/green roofs mitigation reduces electricity
in the summer months, but increases natural gas consumption during the winter (Levinson, R. et. 
al. 2005).  Consequently, the user should enter two values for this mitigation measure.

The mitigation tab also includes a measure to reduce energy efficiency by a percentage beyond 
Title 24.  For example, by specifying that a building will be ten percent more efficient than Title 
24, emissions of electricity and natural gas are assumed to be reduced by ten percent from 
uncontrolled rates, assuming no additional electricity or natural gas has been specified.

Carbon Sequestration Tab
For carbon sequestration associated with tree plantings, a separate tab has been created.  In this 
tab, the user is required to enter the number of trees that will be planted in six separate 
categories: fast, medium and slow growing hardwood trees and fast, medium, and slow growing 
conifer trees.  The user must enter the number of trees planted in the year in which they are to be 
planted.  With that information, BGM estimates the amount of CO2 sequestered annually and 
cumulatively.

The carbon sequestration estimates are based entirely on the carbon sequestration worksheet 
developed by the U.S. Department of Energy (2009).  This workbook estimates carbon 
sequestered by individual ("open grown") trees planted at a "standard" age, defined as typical, 
nursery-raised trees, sold in a 15-gallon container or balled and burlapped.  The carbon 
sequestration calculations account for tree survival rates and the differences in sequestration rates 
by tree type.

Results Tab
The results tab includes both Summary and Detailed Results sections.  

Summary Results
The Summary Results section shows, for each emission category, the unmitigated minus baseline 
and mitigated minus baseline CO2e emissions.  The user has the option of turning baseline 
emissions on or off on the Settings tab.  Two categories – sequestration and purchase of offsets –
are not included in the unmitigated calculations but are included and itemized separately for the 
mitigation estimates.

The Summary Results section also includes a bar chart that shows unmitigated minus baseline 
and mitigated minus baseline emissions for each category.

Detailed Results
The detailed results show CO2, CH4, N20, and metric tons CO2e for the unmitigated, mitigated, 
and baseline scenarios.  In addition, any mitigation measures that have been selected are listed in 
the detailed results section.  The only exception is that transportation mitigation is listed in a 
separate tab: Transp. Detail Mit. 
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Global Warming Potential
BGM assumes a global warming potential
for nitrous oxides (California Climate Action Registry
IPCC in their second assessment report (
of the refrigerant is used, except in cases where a weighted average of refrigerant GWPs is uses 
instead.

Global warming potentials were developed by the Intergovernmental Panel on Climate Change 
(IPCC) to quantify the globally averaged relative radiative forcing effects 
carbon dioxide as the reference gas. In 1996, the IPCC published a set of GWPs for the most 
commonly measured greenhouse gases in its Second Assessment Report (SAR). In 2001, the 
IPCC published its Third Assessment Report (TAR), which
information on atmospheric lifetimes and an improved calculation of the radiative forcing of 
carbon dioxide. However, SAR GWPs are still used by international convention and the U.S. to 
maintain the value of the carbon dio
the SAR convention for calculation CO

Blank Land Uses
Within URBEMIS, users enter information for their project on the land use tabs, such as the 
number of residences and/or square foo
specific land use type is not listed 
have the option of entering one or more 

If the URBEMIS file that you are importing into BGM includes completed “blank” land uses, 
then the imported transportation and area source emissions will include the emissions for the 
blank land uses.  However, other are
and natural gas tab, the water and wastewater tab, and the solid waste tab 
completed blank land use information from URBE
into these three tabs and enter blank land use information.  

Figure 21 shows a portion of the blank land use data entry form located on the electricity and 
natural gas tab.  For each blank land use, the user must enter 
amount of electricity and natural gas that will be used.
incorporated into the project totals.

Figure 21. Electricity and Natural Gas Blank Land Use Data Entry
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BGM assumes a global warming potential (GWP) of 1 for CO2, 21 for carbon dioxide, and 310 
for nitrous oxides (California Climate Action Registry, 2009). These are the GWPs used by the 
IPCC in their second assessment report (IPCC, 1996).  For refrigerants, the actual GWP potential 

is used, except in cases where a weighted average of refrigerant GWPs is uses 

Global warming potentials were developed by the Intergovernmental Panel on Climate Change 
(IPCC) to quantify the globally averaged relative radiative forcing effects of a given GHG, using 
carbon dioxide as the reference gas. In 1996, the IPCC published a set of GWPs for the most 
commonly measured greenhouse gases in its Second Assessment Report (SAR). In 2001, the 
IPCC published its Third Assessment Report (TAR), which adjusted the GWPs to reflect new 
information on atmospheric lifetimes and an improved calculation of the radiative forcing of 
carbon dioxide. However, SAR GWPs are still used by international convention and the U.S. to 
maintain the value of the carbon dioxide “currency“.  Consequently, the BGM model also uses 
the SAR convention for calculation CO2e.

enter information for their project on the land use tabs, such as the 
number of residences and/or square footage of non-residential uses.  Occasionally, a project’s 
specific land use type is not listed on the URBEMIS land use tabs.  In these circumstances, users 

one or more land uses into URBEMIS’ designated blank land use

file that you are importing into BGM includes completed “blank” land uses, 
then the imported transportation and area source emissions will include the emissions for the 

.  However, other areas of BGM that use URBEMIS land use data 
tab, the water and wastewater tab, and the solid waste tab – do not import 

completed blank land use information from URBEMIS.  Consequently, the BGM user must go 
into these three tabs and enter blank land use information.  

Figure 21 shows a portion of the blank land use data entry form located on the electricity and 
natural gas tab.  For each blank land use, the user must enter a land use name, and 
amount of electricity and natural gas that will be used.  The resulting emissions are then 
incorporated into the project totals.
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Figure 22 shows a portion of the blank land use data entry form on the water and wastewater tab.  
The user must enter the land use name and 
CO2e emissions for the blank land use

Figure 22.  Water and Wastewater Blank Land Use Data Entry

Figure 23 shows a portion of the blank land use data entry form on the solid waste tab.  
enters the land use name and the amount of solid waste that will be generated annually
then estimates CO2e for this land use and incorporates those emissions into the project total.

Figure 23. Solid Waste Blank Land Use Data Entry 
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Figure 22 shows a portion of the blank land use data entry form on the water and wastewater tab.  
nd use name and its annual water consumption.  BGM then estimates 

e emissions for the blank land use, which are then incorporated into total project emissions.

Figure 22.  Water and Wastewater Blank Land Use Data Entry
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Figure 22 shows a portion of the blank land use data entry form on the water and wastewater tab.  
BGM then estimates 

are then incorporated into total project emissions.

e blank land use data entry form on the solid waste tab.  The user 
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